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Introduction

OGX Overview

The OGX Portal specializes in improving functionality and ease of use. These are the areas that the OGX Portal shines in:

e OGX Dashboard — The OGX Dashboard allows users to drill down through new reporting panels for funding account
information, program budgets, and even view staff performance information.

e SAM.GOV System Interface — The new system interface automatically gathers address and contact information
during registration and confirms a valid DUNS number. It also allows the system to check for expiration dates and
confirm whether an organization can receive federal funding.

e Easy Configuration of Program Changes — The OGX portal takes advantage of a new drag-and-drop configuration
engine to allow users to make changes to their programs. This includes easily updating forms, process flows, and
management reports.

e Updated Accessibility Features — OGX was built from the ground up to adhere to ADA and WCAG 2.1 AA standards.

The portal will also undergo regular 3™ party web accessibility compliance audits. It includes new options like a high
contrast mode and new branding utilities, making it easier to accommodate individuals with disabilities.

OGX and OCAST has supplied the following contact information for users needing assistance:

Agency/Individual Name  Phone Number Email Address Website URL
Agate Software Helpdesk 1 (866) 4490-1425 azhelpdesk@agatesoftware.com
OCAST, Connor Cox 1 (405) 319-8428 Connor.Cox@ocast.ok.gov www.ocast.ok.gov
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System Requirements

The system was designed so that computer users can use it with little or no changes to their computer environment. The
requirements that are mentioned below are common computer elements that should be already present.

Internet Connection
The grants management system is an internet application designed for and accessed via the internet.

Internet Access

This system was designed to be compatible with common up-to-date web browsers such as Microsoft Edge, Chrome,
Firefox, or Safari. If the web browser is not update, the following message will display:

Your browser is not supported.

Powered by IGX™ systems cannot provide a good experience to your browser.
To use this site, please upgrade to the latest version of Edge. Chrome, Firefox, or Safari

9O

The web browser must enable cookies for this site in order to access this portal.

Do not open multiple windows or browser tabs while filling out the document, as this can cause issues with browser
cookies resulting in either being kicked out of the system or work being lost.

NOTE: If the user needs to have multiple windows open please insure that the user is using a separate browser
session instead.

If utilizing Microsoft Edge, click on File > New Session for each browser session. Other internet browsers will require
third party add-ons to manage multiple browser sessions.

Adobe Acrobat DC

Adobe Acrobat DC (Adobe Acrobat Reader) is used to view PDF (Portable Document Format) documents. The system will
automatically generate grant documents in PDF format using information that has been saved into the various narrative
and budget pages. Using Adobe Acrobat DC, the user may choose to view, print, or save these documents. Users who
do not have this software installed on their systems will need to download it from www.adobe.com.
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System Login Page

URL

To access the OGX portal, type the following into the address bar of the web browser and press Enter.
https://www.ogx.ok.gov

NOTE: If you have an existing user account in OKGrants, then you may login to OGX using your OKGrants User Name and
Password. Upon login you may be asked to change your password; you may use the same password without issue. Be
aware that the OGX portal does not save your User Name and Password. However, this option may be available for
some browsers.

OGX Portal Home Login Page Sections

f;“%. OKLAHOMA

OKLAHOMA GRANT EXCHANGE - OGX

Welcome to the online Grants Management System - OKGrants

Within this system, you are able 1o search for grant epporuniies, track Your project status and subemit requasts for paymeen. This system requires an inisal LOgI n
regrstration process
o ThaAgency Admintstrator (AA) wil compiste the inlial registration process for the crganizatin by salecting the Agency Admiréstrator Registration bution
Only the AA should complete the registration page. Exampdes of an sgency administrator are Executive Director, Grants Manager. Program Dérector,

Username
Mayor, Research Administrstor or CED. .

o Once access Is approved, the AL wil receiv an g-mall and wil designate access Arcess 10 an o only granted by the et
Ak Examples of crganization members are Principal Investigator, Grant Writer, Associate Directos, City Manager or Financisl Officer,

« M an organization member wants access 1o the organization prior 1o the agency administrator adding the member. the agency administrator should b
contactid diroctly instead of using the Agency Administrator Registration page. i any user type besides the AA sedects Agency Administrator

istration, the state syst i will denry the sccount. i the member does. not know who the agency administratos is. the state systom

‘admiristrator can provide the information

« M an organization will pursue funding from multiple state agencies. the AA will contact each agency 10 request access. The Agency Administrator
Registration process should not be used 1o request access 1o multiple organizations. This will result in multiphe accounts.

« Agenty contact information, indhuding e-mall, i also included in thi Show Help on the Welome page
Wike Bray. Oklshoma Highway Safety Office (OHSO). 4055231585, Ema
Casoy Harnass, OCAST Ema

Announcements

This is where announcements will show for OGX users.

Figure 1 The Login Page

The OGX portal login page is organized into Public Reports, Welcome/Announcements, and Login sections.

Welcome/Announcements

This is the section where are welcomed to the portal and allowed to view posted announcements. These
announcements may include links.

OGX Portal Login Section

The OGX portal login process requires a user to enter in a User Name and Password to login.

NOTE: The password field is case sensitive and will not recognize characters of the wrong case. Precision when
entering the username into the username field will decrease the risk of error messages being generated by the
system.

User Name
The user name is created by the new user during the registration process OR by the user adding this user to the
organization.
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Password
The password is created automatically by the portal once a new user is added.

Submit Button
Push the Submit Button to login onto the OGX Portal.

Forgot Username
The OGX portal allows the user to request the retrieval of their username. To do so, complete the following steps:

1) Click on the Forgot Username/Password! link.

Login

User Name

Password

Forgot Username/Password! I

2) Click on the Forgot Username link.

Forgot Password

Email

| |
Username

Forgot Username
Clear

1) Enter the email address and click on the Email button. An email will be sent to that email address with the user’s

username.

2) The user can follow the instructions in the “Forgot Password” section to allow them to log into the system.

“Locked Out”
Once a user has exceeded 3 login attempts for the portal, they are “locked out”. The user may use the Forgot Password

link to request a temporary password at any point. Instructions for using the “Forgot Password” link are provided
below.
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Forgot Password
The OGX portal allows the user to request a temporary password be generated and sent to their email address. To do so,
complete the following steps:
1) Click on the Forgot Username/Password! link.
2) Enter the username and the email address. Click on the Email button. A temporary password will be sent to the
email address supplied.

Forgot Password

Email

Username

Forgot Username
Clear

3) Once the user has received a temporary password, they will need to login.
NOTE: The password field is case sensitive and will not recognize characters of the wrong case. Precision when
entering the username into the username field will decrease the risk of error messages being generated by
the system.

4) At that point, the user will be brought directly to the Profile page and requested to create a new password. The
user can use the Edit Password button at the bottom of the page to update the password. When the user clicks
on the Edit Password button, the Password and Confirm Password fields are available.

Password Confirm Password

New User
The OGX portal allows the user to request access to the system. To do so, complete the following steps:

1) Click on the New User? Click Here link.

Login

Username

Password

Forgot Username/Password?

I Agency Administrator Registration I

2) Fillin the required fields (*) and any optional fields desired and click on the Save button.
NOTE: Users registering by the New User link will need to be approved by pre-existing OGX portal users.
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NOTE: If a user attempts to access the system before they have been approved, the system will show their
password as invalid.

New User Registration x

First Name Middle Name

| | | |

Last Name

| |

Organization Title

| || |

Address Address 2

| || |

State County

| Oklahoma V| | V‘

City Zip Code

| || |

Email Phone

| || |

Username

| |

Password Verify Password

| || |
(=]

Legend
First Name (Required) — the first name of the registering user.

Middle Name — the middle name of the registering user.

Last Name (Required) — the last name of the registering user.

Organization (Required) — the name of the organization the registering user wants to register under.
Title — the position title of the registering user.

Street Address (Required) — the street address of the organization the user is registering for.

State (Required) — the state drop-down selection for the state of the registering user’s organization.
County (Required) — the county drop-down selection for the county of the registering user’s organization.
City (Required) — the name of the city of the registering user’s organization.

Zip Code (Required) — the zip of the registering user’s organization.

Email (Required) — the email address of the registering user.

Phone (Required) — the phone number of the registering user.

Username (Required) — the username the registering user wishes to register for.

Password/Verify Password (Required) — the password the registering user wishes to register for.

User Information

Once a person logs into the system, their Profile page and a list of organizations the individual belongs to is visible.

10/15/20 Copyright © Agate Software, Inc. Page 9 of 25
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Profile

Profile

Basic Information

First Name Middle Name

‘ Subgrantee Recipient ‘ ‘

Last Name Prefix Suffix

‘ Testing ‘ ‘ v

Title

‘ Testing ‘

Primary Phone Secondary Phone

‘ 5555555555 ‘ ‘

Email

‘ ajurgensen@agatesoftware.com

Address Information

Street Address

2014 University

City State
‘ Okemos ‘ ‘ Kentucky
zZIP County

‘ 48866 ‘ ‘ Adair County

Additional Information

Job Certification

Security Image

i |eiNo Image Selected Update Security Image

Username

TestingRecipientAdmin = s

Password Edit Password
F*hEkkhkikhk

Basic Information Legend
First Name — the first name of the individual.
Middle Name — the middle name of the individual.
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Last Name — the last name of the individual.

Prefix — an optional prefix for the individual.

Suffix — an optional suffix for the individual.

Title — the position title for the individual.

Primary Phone — the primary phone number for the individual.

Secondary Phone — the optional secondary phone number for the individual.

Email — the email address of the individual.

Street Address — the street address for the individual.

City — the city the individual’s street address is in.

State — the dropdown menu of the state the individual’s street address is in.
Zip — the zip code the individual’s street address is in.

County — the dropdown menu of the county the individual’s street address is in.

Job Certification — a repository for uploading personal certification forms.

Security Image — an optional security image to implement as an additional security measure.

Username — a label containing the username of the individual and a button that allows the individual to update the

username.

Password — a label containing the current password of the individual and a button that allows the individual to update

the password.

Organizations

This section contains a table with the label for the role the individual has in that organization, the active date field, the
inactive date field, and the name of the person who assigned that individual to the organization.

NOTE: A person can have multiple organizations listed.

10/15/20 Copyright © Agate Software, Inc.
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Home

The Home page is the home page for OGX portal users. From here, the rest of the system can be navigated.

;::"- OKLAHOMA

OKLAHOMA GRANT EXCHANGE - OGX
Home Administration « Searches « Reports « O 8 ? OHSO System Administrator IGX «

Dashboard

My Tasks My Opportunities
s

Announcements

Tabs

This is a navigation link that will return the user to the Home page from anywhere in the system.

This is a navigation link that will allow the user to conduct document searches for that organization. The user can access
this link from anywhere in the system.

Menu Options

e Applications

e Financials

e Programmatic Reports

Icons

Theme

Setting This button switches the theme visible from black and white to color and vice versa.
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Tralnlr‘Ig Clicking this button allows the user to view available training materials
Materials
Help Clicking this button allows general help tips to display about the current item selected.
Name Clicking on the user’s name allows the user to access the Profile, Messages, Edit
Dashboard, and Logout links.
Dashboard

The My Tasks area is an area that defines the tasks assigned to the user. It also gives the user a way to initiate a related
document (like a report or requisition). This area can be filtered using the Filter function.

My Tasks

> Filter

> MyTasks =l

Using the My Tasks Filter

To use the My Tasks Filter to on a list of tasks assigned to the user, please follow these instructions:
1. Click on the > sign next to the Filter header.
2. Enter data into any of the fields and/or select an option from the Type drop-down.
3. Click the Search button.

1. Filter

Name Organization

2| | |

Status Type
N |

The Announcements area is an area that allows the user access to announcements from the portal designers. These
announcements can include (but are not limited to) training dates, news updates, or web site links.
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Announcements

Grant System Training is coming soon. Select this link to sign up!

State Agency receives Federal Award

Visit our website by using this link: https:/fintelligrants.com

Test Announcement

The My Opportunities area allows the user to start grant opportunity documents (usually applications).

My Opportunities

Provider Availability

Sample Program Application  Base Provider Organization  5/4/2019 10:00:00 AM -
5/25/2022 9:30:00 AM

Short Description

sample Funding Program for
the IGX System

Sample Program Base Provider Organization  5/4/2019 10:00:00 AM -
Applicationnnnn 5/25/2023 9:30:00 AM

Sample Funding Program for
the IGX System

State as Grantee Application  Base Provider Organization  1/30/2019 12:00:00 AM -

Application to apply for
Federal/Other funding

10/15/20 Copyright © Agate Software, Inc. Page 14 of 25
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Grant Opportunities

Starting a Grant Opportunity

To start a grant opportunity, please follow these instructions:

1) Click on the grant opportunity name in the Name column. This brings up a menu with more information and the

Agree or Decline buttons.

Sample Program Application

Provided By: Base Provider Organization

Provided To: Agate Software

Application Availability Dates: 5/4/2019 10:00:00 AM - 5/25/2022 9:30:00 AM
Description:

Sample Funding Program for the IGX System

Agreement Language:

this Application document on behalf of Applicant. I also attest that the Applicant is eligible to apply for this RFP.

By selecting the Agree button below, | attest that | am a duly authorized representative of the Applicant. and have been authorized by
Applicant to make all representations, attestations and certifications contained in this RFP and all Addenda, if any issued. and to execute

2) Click on the Agree button.

Working on a Grant Opportunity
Start the grant opportunity using the instructions in the previous section.
NOTE: The default page for the application is the Document Landing Page.

The Document Landing Page contains several sections and the New Note button.

;::{» OKLAHOMA

Home Administration - Searches -

HR20-013

! Document Landing Page

v 5
Forms View document details.

Application FY20 Health Research Program FY20 Health Research Program QCAST Application

HR20-013
Principal Investigator

e v B ertn?

liGrants Administrator

Period Date
1/1/2020 12:00:

Project information

OKLAHOMA GRANT EXCHANGE - OGX

OGaE

Randall Shell
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Application Link
The number listed above the Forms header is the application number. It also functions as a link to bring the user back to
the Document Landing Page.

Forms Menu
The Forms Menu is divided into sections containing individual forms for the user(s) to fill in. There are drop-down
arrows next to the Forms header that allow the forms to be hidden and other sections uncovered.

HR20-013

? Forms

9> Tools

¥ Status Options

? Related Documents

Legend

Forms — the list of forms. Usually forms without sections are listed first, then the form list is broken in to sections.
Tools — a list of tools available to the user.

Status Options — a list of possible status options to apply to the application. This list will vary from user to user,
depending on which role the user is logged in as and current status of the application.

Related Documents — a list of related documents (primarily reports) associated with the application.

Document Details
The Document Details section provides visual data including the grant opportunity status, future statuses, the name of
the organization, the role of the user currently logged in, and both the Period Date and Due Date.

New Note Button
The New Note button allows a user to leave a note for other users.

Grant Opportunity Forms

The list of forms is usually divided into sections, with the first section visible being the default form location.
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¥ Forms

Application

Principal Investigator
Information

Project Information

Performance Sites and
Compliance

Contract Official

Clicking on a form link in any section will bring up that form for the user to fill in.

% oxLanoma OKLAHOMA GRANT EXCHANGE - OGX
Home 1 Searches - Reports - O=: 8 ? System Administrator OCAST «

i | Principal Investigator Information

MNow Note

¥ Forms

[l Instructions:
Application Please complete this page and click Save, Any ermors will be noted after saving. Required fields are marked with *

Form Options
There are additional tools in the purple banner on the right side of the screen.

O c/; Testing Admin ~

- NewNote | Save | Add | Delete

Legend
New Note — allows the user to create a new note for other users.
NOTE: For more information, please see the Notes section in the Tools area.

Save — allows the user to save the form.
Add — allows the user to create an additional instance of the form. It is the digital equivalent to being handed an extra
piece of paper of a specific form to staple to an existing packet of forms.

Delete — allows the user to delete the instance of the form that is visible to the user. Clicking on the Delete button will
clear out the fields on the form (including any uploaded attachments).
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Tools
The Tools section contains a list of customized tools available to the user depending on the role assigned to the user.

¥ Tools

Landing Page

Add/Edit People

Attachment Repository

Modification Summary

Status History

Notes

Print Document

Legend Summary

Landing Page — the default application page.

Add/Edit People — allows the user to add/edit people associated with a specific document.
Attachment Repository — allows the user to access a list of stored attachments.

Modification Summary — allows the user to access a summary of modifications for a specific document.
Status History — allows the user to access a history of the status(s) of a specific document.

Notes — allows the user to create/view/edit notes for a specific document.

Print Document — allows the user to create a PDF of the document.

Landing Page
Clicking on this link returns the user to the Document Landing Page.

Document Add/Edit People
This tool allows authorized users to add/edit people assigned to the document.

v People Assigned to this Document

Person Organization Role Active Dates Assigned By

a.a Agate Software Authorized Official 10/18/19 - Grant System

Adding/Assigning People to the Document
To add/assign a person to the specific document, please follow these instructions:
1) Click on the Plus Sign button on the People Assigned to this Document row.
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2) Select the Person and Role options from the drop-down menus.

3) Click the Save button.
NOTE: This will automatically assign today’s date. If a past active date is required, please use the menu in the
Active Date field to select the date.

Document Person

Document Person Search

Name Role Organization Name

| . 1| |

Clear Search

Editing People Assigned to the Document
To edit the role of a user assigned to the specific document, please follow these instructions:
1) Click on the Pen button on the right side.
2) Select a role from the Role drop-down list.
Optional: Update the Active Date field.

3) Click the Save button.

Document Person X

Person
TEST, TESTAA

Role

l Agency Administrator V|

Active Date Inactive Date

l 09/20/2020 I ‘ |

Attachment Repository
This tool allows the user to view files that have been added as attachments throughout the document.
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Document Modification Summary
This tool allows the user to view and/or download the modification summary.

Status History
This tool allows the user to view the status of the document — including the Status name, Date/Time the document had

that status, and the name of the Person who changed the status of that document. There is also a field for status notes.

Notes
This tool allows the user to add/edit notes.

$1% oKLaHomA OKLAHOMA GRANT EXCHANGE - OGX

1l

Home Administration - Searches - eports - Oa B8 System Administrator OCAST -

i Notes Q

Farm

Modifkation Changes. (=]

¥ Tools

Landing Page:

Adding a New Note
Please use these instructions to create a note.

1) Click on the New Note button.
2) Fillin the field.
3) Click on the Paperclip icon to add a note (optional).
4) Click on the Paper Airplane icon to SAVE the note.
Additional Fields
Icon Name Description
Internal Note This tool locks this note into the form as an internal note. The internal notes are only
& visible to members within the same organization.
Attachment(s) This tool allows the user to add attachments to the note.
&é
Editor This tool allows the user to edit a note.
'¥'ﬁ
Save Note This tool allows the user to save the note.
A

Locating a Note
Once a note is created, it ends up in the Notes area of the Tools menu.

To access the note, please follow these instructions:
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1) Click in the Forms section to minimize that section.
2) Click on the Notes link in the Tools section.

Notes Q

Instructions go here

[a]

& Edit VF
W Delete
Testing Admin - 10/22/2019 1:24:40 PM
&TEST & External
& Edit
Testing Admin - 10/22/2019 1:24:02 PM

TEST

W Delete -
& Internal

Updating a Note

1) Click in the Forms section to minimize that section.
2) Click on the Notes link in the Tools section.
3) Clickonthe...i

& |~l-T4a

& Edit
W Delete

& External

4) Click on the Edit tool to edit the text field.

. icon. This brings up the Edit, Delete and External/Internal tool buttons.

Testing Admin - 10/22/2019 1:24:40 PM

Formats ~

TEST

Select

5) Click in the text field to adjust the formatting and/or the contents of the note.
6) Click the paper airplane icon to save the updates to the note.

Deleting a Note

1) Click in the Forms section to minimize that section.
2) Click on the Notes link in the Tools section.
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3) Click on the ... icon. This brings up the Edit, Delete and External/Internal tool buttons.

& Edit
W Delete
& Internal

]

(1)

4) Click on the Delete button to delete the note.

Replying to a Note

1) Click in the Forms section to minimize that section.

2) Click on the Notes link in the Tools section.

3) Add a response to the Reply section and click on the airplane icon.

Testing Admin - 10/22/2018 1:24:40 PM
@ TEST

Testing Admin - 10/22/2019 1:42:33 PM
TEST2.0

.

Print Document

This tool allows the user to create a PDF version of the document to save onto the user’s computer and/or print out.

Each form has the option of being included in the printout (with both questions and answers), excluded in the printout,

or including a blank version of that form.

ALL

JST TEST 5/26

Form 1

Form 2

Testing Hidden Variables

Testing Print Versions Stackable Form

Include

OR

Exclude

nclude Blank
Copy

The Status Change area allows the user to change the status of a document. This is normally useful for submitting

applications, signing contracts, or requesting grant modifications.
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¥ Status Options

Application Submitted

Application Cancelled

Related Documents
The Related Documents section is where the user can access documents (such as reports) that are related to the
application/contract.

Accessing a related Document
To access a report, please follow these instructions:
1) Navigate to the grant.
2) Close the Forms, Tools, and Status Options sections.
3) Click on the report link in the Related Documents section.
4) Click on the report link in the 2" column. This will bring up the Document Landing Page for the report.

OHSO-FFY2021-JTO- OHSO Monitoring Report
00006 OHSO Manitoring Report Q1

]

OH50-MRQ1-2020-JTO-00002:
Monitoring Report Available
for Review

? Forms

¥ Tools —
OHSO Maonitoring Report Q2

OHSO-MRQ2-2020-JTO-00003: —4

¥ Status Options
Monitoring Report In Process

+ Related Documents 0OHSO Monitoring Report Q3

OHSO-MRQ3-2020-JTO-00004: 4

B Initiate Related Doc Monitoring Report In Process
A

OHSO Request For Payment

OHSO Progress Report

OHSO Monitoring Report

Starting a Related Doc
Click on the Initiate Related Doc button (either in the Related Documents section or in the My Tasks area of the

Dashboard).
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Searches

The Searches tab is used to quickly locate specific documents. Different types of searches have their own search
sections set up. The sections below explain how to use these search sections.

Applications
To use this search tab, please follow these instructions:
1) Go to Searches - Application/Grant.
2) OPTIONAL: Enter in search parameters. Click the Clear button to clear out search parameters.
3) Click the Search button.
4) Click on the name of a specific document in the Name column.

Document Search

Name Organization

Type Status
Sub Code

¥ Documents B

Organization Status Sub Code

Legend
Name — A text field for the name of the document.

Organization — A text field for the name of the organization that created the document.
Type — A drop-down list to select the type of document from.

Status — A drop-down list to select a specific document status from.

Sub Code — A text field to enter the sub code of the document in.

Financials
To use this search tab, please follow these instructions:
1) Go to Searches = Financials.
2) OPTIONAL: Enter in search parameters. Click the Clear button to clear out search parameters.
3) Click the Search button.
4) Click on the name of a specific document in the Name column.

10/15/20 Copyright © Agate Software, Inc. Page 24 of 25




OCAST OGX - User Guide Version 1.1

Document Search

Name Organization

Type Status

Sub Code

¥ Documents

Organization

Progress Report

Base Applicant Organizatior

PR-Demo-2018-0073

Status

Progress Report In Process

Programmatic Reports
To use this search tab, please follow these instructions:
1) Go to Searches - Programmatic Reports.

2) OPTIONAL: Enter in search parameters. Click the Clear button to clear out search parameters.

3) Click the Search button.
4) Click on the name of a specific document in the Name column.

Document Search

Name Organization

Type Status

Sub Code

¥ Documents

Organization

Progress Report

Base Applicant Organization

Status

rogress Report In Process
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